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This module focuses on how to perform recoveries of client data in NetWorker. We will look 
at all the types of client recoveries that are supported by NetWorker, including: Browsable, 
save set, directed and filesystem snapshot recoveries . 
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This lesson covers an introduction to the three types of NetWorker recoveries, how to use 
the various NetWorker recovery utilities, as well as volume and storage node selection for 
recoveries.  
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A recovery restores data to its original state at a specific point in time. NetWorker is flexible in 
how recoveries are performed while at the same time maintaining necessary security to avoid 
recovery of data by non-authorized persons. NetWorker supports restoring one or more 
individual files, directories or file systems from NetWorker client backups. The three types of 
recoveries that we discuss in this module are: Browsable, Save Set, and Directed.  

Recoveries can be categorized by the method used to recover the data. In a Browsable 
Recovery, the administrator or user browses and selects the set of files and directories to be 
recovered using interfaces that require information from the client file index.  

In a Save Set Recovery, data is recovered by selecting a save set.  

A Directed Recovery is any recovery in which data that was backed up from one computer is 
recovered to another.  

Module 8: Performing NetWorker Recoveries  3 
https://t.me/learningnets



   Copyright © 2013 EMC Corporation. All rights reserved 

Browsable Recoveries are the most flexible and easy to use method of recovering data. 
Consider using a browsable recovery when you want to recover only the files that you mark 
for recovery and no other files. Also, when you don’t know the exact name of a file, the file 
can be located by browsing through the file system. When recovering an entire directory or 
file system, a point-in-time recovery is automatically performed. This restores the directory 
or file system to the way it looked as of the most recent backup. Because of the point-in-time 
feature, browsable recoveries are useful when the most recent backup is not a full backup 
and files have been deleted or renamed since the full backup. The recovery will not restore a 
file that has been deleted and will recover a renamed file only with its current name.  

A Save Set Recovery can be performed at any time for any save set. By default, an entire save 
set is recovered. However, you can recover individual files and directories. A save set 
recovery is commonly done: 

• When the last backup was a full backup and you want to recover the entire save set. 

• When a large number of files are being recovered from a single save set.  If a save set 
has millions of files, the process of marking each file for recovery during a browsable 
recovery can take a considerable amount of time. A save set recovery does not 
require marking each file and thus can lead to faster file recovery. 

• When the save set being recovered is no longer browsable, it can only be recovered 
using save set recovery. 
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In any recovery, there are three client roles - administering client, source client, and 
destination client - that are performed by one or more NetWorker hosts. 

Following is a description of the three client roles in a recovery: 

• Source client:   The NetWorker client from which the data being recovered was 
originally backed up. 

• Destination client:  The NetWorker client to which the data is being recovered. 

• Administering client:  The NetWorker client (local host) performing the recovery. 

The most common recovery is where a single NetWorker client performs all three roles.  For 
example, you might be logged in on hostA (administering client), recovering data previously 
backed up from hostA (source client), to its original location on hostA (destination client). 
Another example of a common recovery is initiating a recovery of a remote client’s files from 
a central administering client.  For example, the administrator may perform a recovery from 
HostB (administering client) of a file backed up from HostA (source client) to HostA 
(destination client). 
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When a single client performs all three client roles in a recovery, there are no security issues; a 
client’s data can always be recovered back to the client. The user on the client must belong to a 
NetWorker user group that has the Recover Local Data privilege (members of the NetWorker 
Administrators and Users user groups automatically have this privilege.) The user also must 
have operating system ownership of the files being recovered and have write privileges to the 
directories where the data is recovered. 
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Recoveries in NetWorker are manual processes initiated from a NetWorker client. NetWorker 
does not schedule recoveries or perform them automatically.  

From Microsoft Windows clients, recoveries can be performed using the NetWorker User 
graphical user interface. Select NetWorker User from Windows > Start or from the Start menu 
in NetWorker Administration. 

Recoveries may also be performed from the command line by using the command, recover, 
on any NetWorker client. 

Additionally with NetWorker 8.1 and higher the Recovery Wizard has been introduced.  The 
recovery Wizard allows you to perform most NetWorker recoveries through the NetWorker 
Management Console without having to log into the client or any other application. 
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To restore a client’s data using NetWorker User, first select the type of recovery that you 
want to perform. From the Operation menu select Recover/Directed Recovery to run a 
browsable recovery; select Save Set Recovery to perform a save set recovery. You are then 
prompted for the source client whose data you will restore. The Source Client window only 
contains clients for which the administering client has remote access privileges. When 
performing a browsable recovery, you are then prompted for the destination client. This is 
the same as the source host unless you are performing a directed recovery. After selecting 
the data to be recovered (either by file or by save set selection), click Start (green lightening-
bolt) to begin the recovery. 
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The NetWorker recover command is available on all NetWorker clients. The recover 
command runs in either of two modes: interactive (default mode) or non-interactive (-a 
option). Interactive mode allows you to use subcommands in a shell-like environment. With 
the subcommands, you can navigate the CFI, mark files for recovery, and perform most of the 
functions available when using NetWorker User or NetWorker Recover. 

recover(1m) syntax: 

     recover [ -options ] [ pathname ... ] 

recover automatically assumes the source client is the same as the administering client. 
To specify a different source client, use the –c option.  If the administering client is 
configured as a NetWorker client in multiple data zones, you can use the –s option to specify 
the NetWorker server that will control the recovery. 

The pathname argument is either the path to set as the initial working directory for browsing 
(interactive mode) or, if the -a option is used (non-interactive mode), the path(s) to recover. 
The default initial working directory is the current directory. 

Note:  See The EMC NetWorker Command Reference Guide for more information including a 
description of the command options and subcommands. 
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By default, NetWorker recovers data by attempting to return a file to its original folder using 
its original file name. However, if another file with the same name already exists in the 
folder, a file naming conflict occurs. NetWorker prompts you for how to resolve the conflict. 
The choices are: 

• Rename the file being recovered. The existing file is untouched and the file being 
recovered is recovered to the same folder, but with a different file name. By default, a 
tilde (~) is placed in front of the original name, but when prompted, you can specify 
any name you like. If another file with a name of ~filename already exists, an 
additional tilde is pre-pended to the new name. As many tildes will be added as is 
necessary to make the filename unique. 

• Discard the file being recovered. The existing file is untouched and the recovered file 
is discarded. 

• Overwrite the existing file. The existing file is deleted and replaced by the recovered 
file. 

Alternatively, you can choose to relocate the recovered data to a different directory. The 
folder you specify in the Relocate recovered data to field will be created if it does not exist.  
Subfolders are created as necessary to retain the folder hierarchy that existed when the files 
were backed up. There may be times when you want to recover a set of files to a location 
other than the folder from which they were backed up.  Relocating recovered files is useful 
for comparing an existing set of files with the same set of files that were previously backed 
up.  

Note: In NetWorker User, you can select the action to be performed when a file naming 
conflict occurs prior to beginning the recovery.  
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After making a selection of the data to be recovered, users can view a list of the volumes 
needed to recover the data marked for recovery.  If a volume is currently mounted, the 
device on which it is mounted is also displayed.  
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You can monitor the recovery in the Status window which opens as soon as the recovery 
begins when using NetWorker User and NetWorker Recover. 

Important: Do not close the Status window until a recover completion message is displayed. 
Prematurely closing the window aborts the recovery. 

When running recover, information about each file in the recovery can be displayed by 
using the verbose subcommand. 
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Where there is potentially more than one volume for recovery, the highest priority is given to 
the volume containing a complete, non-suspect save set status. If all volumes still have equal 
priority, then priority is given to the volume that is mounted. If all the volumes are mounted, 
then priority is given according to media type, with AFTD having top priority. Next in priority 
is location, with highest priority given to volumes in a library.  

Note: Save set status can be changed with options available in the NetWorker Administration 
Media window and with the nsrmm command. 
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When a recovery is initiated, the NetWorker server selects the storage node to read the 
volume(s) based on the following prioritized criteria: 

1. If the volume to be read is already mounted on a device, the storage node controlling that 
device is used. 

2.The first storage node listed in the Recover storage nodes attribute of the NetWorker client 
resource that is being recovered having access to the required volume. 

3.The first storage node listed in the Storage nodes attribute of the NetWorker client 
resource that is being recovered having access to the required volume. 

4.The storage node listed in the Read hostname attribute of the jukebox resource, or if this is 
empty, storage nodes on which a device in the library is configured. The Read hostname 
attribute in the Configuration tab of the jukebox resource specifies the storage node to 
use for recoveries and cloning if a client’s preferred storage nodes are not available. The 
default value of this attribute is the hostname of the storage node controlling the first drive 
in the library. 
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NetWorker 8.1 includes a new recovery wizard that allows you to recover data from a NMC 
GUI. The recovery wizard supports browsable, save set and directed recoveries. This wizard 
does not support cross-platform recoveries . The recovery wizard allows you to create  and 
save a configuration that you can reuse and modify later.  
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Select the source host , destination host and the recovery type. Before starting the recovery 
wizard ensure the following requirements. The destination host is a client of the NetWorker 
server and are running on Networker 8.1  or later software. And for the directed recovery , 
the remote access attribute of the source client must contain the host name of the 
destination client.   

Before you recover data to a different host , ensure that remote access attribute under the 
properties of the source host must contain the name of the destination host. 

Module 8: Performing NetWorker Recoveries  16 
https://t.me/learningnets



   Copyright © 2013 EMC Corporation. All rights reserved 

The browse tab in the window provides you with the ability to browse for the files and 
directories to perform a by file selection recovery from a specific date and time. Follow the 
other attributes and tabs to browse and recover specific required files or directories . 
Recovery list table displays the information about the files and folders that are marked for 
recovery. The recovery wizard organizes the information in following sortable columns. The 
recover wizard enables you to customize the location of the recovered data. The file path for 
recovery group box has two options. 1. Original Path 2. New destination path. 
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Next the window enables you to determine how the recovery wizard selects the volume 
required for data recovery.  

This has two options  

1. Allow NetWorker to select the required volumes for recover  

2. View the required volumes and optionally select alternate volumes of cloned data if 
available.  

The required volume provide a list of volumes to perform the recovery operation. Now you 
can start the recover now or schedule the recovery to start later.  
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This lesson covered an introduction to the three types of NetWorker recoveries, how to use 
the various NetWorker recovery utilities, and volume and storage node selection for 
recoveries. 

Module 8: Performing NetWorker Recoveries  19 
https://t.me/learningnets



   Copyright © 2013 EMC Corporation. All rights reserved 

This lesson covers browsable recoveries including performing a point-in-time recovery and 
using the features of the NetWorker interfaces to perform a browsable recovery.  
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A browsable recovery can only be performed on a browsable save set. Any user is able to 
perform a browsable recovery. However, only those files for which the user has read 
permission can be recovered. During a recovery, the user selects the set of files and 
directories to be recovered. 

When recovering an entire directory or file system, a point-in-time recovery is automatically 
performed. This restores the directory or file system to the way it looked as of the most 
recent backup.  
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If the recover program determines that multiple save sets (a full and its dependent save sets) 
are required for the recovery, it uses the CFI to determine if any files were deleted in the 
time between the most recent full backup and the most recent non-full backup. These 
deleted files are not recovered. Likewise, the CFI is used to determine if a file was renamed 
since the most recent full backup. If it was, the file will be recovered only with its most 
recent name. 

By default, a browsable recovery restores data as of the most recent backup. A browsable 
recovery can also be performed to restore data as of a date in the past. 
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In a browsable recovery, the recovery interface shows a representation of a client’s directory 
structure as it existed at a specific point in time. This representation is generated from the 
contents of the client’s CFI and can be browsed much the same way you would traverse a file 
system in Windows Explorer.  However, the difference is, for a recovery, you are viewing the 
contents of the CFI and not the files residing on disk. 

By default, NetWorker recovers the most recent version of each file selected for recovery. 
When recovering an entire folder or file system, it may be that some files are restored from 
the most recent full backup while others are restored from a more recent incremental or 
level backup. Recovered files retain the same file attributes (modification time, permissions, 
etc.) they had when they were backed up.  

When a folder is selected, file details, including the date and time of last backup, the size of 
the file, and the date last modified, are displayed. You can change the fields that are 
displayed with the options in the View menu in NetWorker User. 
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It is possible to recover a version of a file other than the most recent version.  First, highlight 
the file you want to recover.  Then, select Versions from the View menu. NetWorker displays 
all versions of the file. One or more versions of a file can be selected for recovery.  

To view the versions of a file using NetWorker Recover, select Versions from the Selected 
menu. 
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The set of files displayed within a recovery utility is determined by the recovery browse time. 
By default, the browse time is the current date and time. Based on the CFI contents from the 
most recent full backup and subsequent level and incremental backups, NetWorker is able to 
determine what the directory structure on disk looks like as of the most recent backup. That 
directory structure is what you are presented with in the recovery interface. Thus, if you 
mark and recover all files that are displayed, your computer will be restored to how it was at 
the time of the last backup. 
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You can change the browse time to a date in the past, causing the NetWorker recovery 
interface to display (and recover) only files backed up prior to the browse time. Marking a file 
for recovery automatically selects the most recent version of the file backed up prior to the 
browse time.  

You might want to change the browse time if you need to: 

• Retrieve an old version of multiple files. 

• Retrieve an old version of an entire directory, file system, or client. 

• Look for a file that is still browsable but is not displayed in the GUI. This can happen if 
the file was deleted prior to the most recent full backup. 

Changing the browse time is an option in all NetWorker recovery interfaces. In NetWorker 
User, the option is found in the View menu; in NetWorker Recover, the option to change the 
recovery browse time is located in the Options menu; use the changetime subcommand 
with the recover command to change the browse time. 

Important: If you need to recover files from different points in time, either use the View 
Versions feature for each file or perform multiple recoveries with different browse times.   
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The find feature allows you to locate a file or directory by typing its name. This feature is 
particularly useful in situations where: 

•  You do not know which directory contains the file you want to recover. 

•  You want to recover a file that is still browsable but was deleted from disk before the 
last full backup.  Recall that the recovery interfaces support point-in-time recovery by 
displaying only those files it believes were on disk as of the most recent backup. 

Find is an option under the File menu for both the NetWorker User and NetWorker Recover 
utilities. When specifying the file or directory to locate, the wildcards ‘*’ (match zero or more 
occurrences of any character) and ‘?’ (match any one character) are allowed. The search is 
not case-sensitive. The search begins with the highlighted folder or specified directory and 
descends into its subfolders.  Files and directories matching the search criteria are displayed 
and can be selected for recovery.  

Note: The ability to view file properties is especially important in NetWorker Recover 
because the search results pane does not display the directory location of the matching 
items. Where there are multiple files with the same name in different directories, use the 
properties feature to determine the location of the file to be recovered. 
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With recover, the default method of recovery is by file selection. In the example on the 
left of the slide, the files in the /etc/init.d directory are being recovered. The add 
command is used to add the current version of the file to the recovery list. 

In the example on the right , the versions command is used to determine that a previous 
version of the file, myfile, was backed up on May 10. To recover that version of the file, 
the changetime command is used to change the browse time to a time early in the morning 
of May 11 making the backup on May 10 the most current version prior to the new browse 
time. After adding that version of the file to the recovery list, the list command is used to 
verify that it was added. 

Note:  See the NetWorker Command Reference Guide for more information including a 
description of the command options and subcommands. 
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This lesson covered browsable recoveries including performing a point-in-time recovery and 
using the features of the NetWorker interfaces to perform a browsable recovery.  
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This lesson covers save set recoveries including recovering to a specific point in time and 
using the features of the NetWorker interfaces to perform save set recoveries.  
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A save set recovery is useful when recovering non-browsable save sets but can be performed 
for any save set. After a save set goes from a browsable status to recoverable, it can only be 
recovered using a save set recovery. System administrator privileges are required to perform 
a save set recovery. 

One or more save sets are specified during the recovery. Although the default behavior is 
that each save set is entirely recovered, you can specify a set of individual files or directories 
to be recovered instead. 

Since a save set recovery does not utilize CFI information, it does not perform a point-in-time 
recovery.  

 

Module 8: Performing NetWorker Recoveries  31 
https://t.me/learningnets



   Copyright © 2013 EMC Corporation. All rights reserved 

The ability to automatically recover to a point in time is not supported using a save set 
recovery. 

Let’s assume that save sets backed up on Days 1-6 were browsable for only one month. Now, 
on Day 36, none of those save sets are browsable and you want to recover the file system to 
the way it looked after the incremental backup on Day 6. The following steps must be 
performed: 

1.  Recover the Day 1 Full save set. 

2.  Recover the Day 5 Level 5 save set. 

3.  Recover the Day 6 incremental. 

4.  If no files were deleted or renamed between Day 1 and Day 6, the file system is now fully  
     and accurately recovered. However, if deletions occurred, files which didn’t exist on Day 6   
     were recovered in the Day 1 or Day 5 recoveries. Additionally, if a file was renamed, it will  
     now exist under both its original and new names. For the recovered file system to  
     accurately reflect the Day 6 file system, you must determine which deletions and renames 
     occurred and manually perform them again.  
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The number of full and incremental save sets needed for recovery depends on the schedule 
(backup levels) used immediately prior to the point in time you wish to recover the data. 

To identify the save sets you need for a save set recovery: 

1.  Identify the most recent full backup of the save set. 

2.  Identify the most recent backup at each level, starting with Level 1 and ending with  
      Level 9.  Ignore unused levels. 

3.  Identify the oldest incremental backup (if incrementals are used) that was performed 
     after the most recent level backup. 

4.  Identify the next oldest incremental backup. 

5.  Repeat Step 4 until you reach the desired point in time. 

In the example shown on the slide, a recovery is performed after Day 7’s backup. To perform 
the recovery, you need the Full save set from Day 1, the Level 7 save set from Day 4 and the 
incremental save sets from Days 5, 6, and 7. 
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A save set recovery does not reference the client file index where deleting and renaming of 
files is recorded. This leads to the following behavior: 

• Directories and files deleted during the backup cycle are recovered. 

• Directories and files renamed during the backup cycle are recovered multiple times, 
once for each name by which they were known. 

When you have recovered the last save set required to restore your data to a specific point in 
time, you may need to perform additional file handling. This could include deleting files and 
directories that were deleted during the backup cycle and renaming files that were renamed 
during the backup cycle. 

 

Module 8: Performing NetWorker Recoveries  34 
https://t.me/learningnets



   Copyright © 2013 EMC Corporation. All rights reserved 

From the NetWorker User application select the operation menu and select Save Set Recover. 
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When performing a save set recovery, the recovery utility displays a list of save set names 
backed up from the client. After selecting the save set, all save sets with that name are 
displayed. One or more versions may then be marked for recovery.  

As with browsable recoveries, you can perform searches and view properties, versions and 
volumes for selected items. 
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Be default, save sets are recovered in their entirety. If paths are specified for a save set, then 
only the specified files or directories are recovered. Any path name beginning with a value 
specified in the field is recovered.  
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To perform a save set recovery with the recover command, use the –S option followed by 
the SSID of the save set. Multiple –S options can be used in the same command. A save set 
recovery using the command line is always non-interactive.  

Notes:  Before performing the recovery, determine the SSID of the save set to be recovered 
using NetWorker Administration or the mminfo command. 

See the NetWorker Command Reference Guide for more information including a description 
of the command options and subcommands. 
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This lesson covered save set recoveries including recovering to a specific point in time and 
using the features of the NetWorker interfaces to perform save set recoveries.  
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This lesson covers directed recoveries including privileges and platform requirements and 
using the features of the NetWorker interfaces to perform directed recoveries. 
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A directed recovery is defined as a recovery in which the data that was backed up from one 
computer is recovered to another.  

The benefits of performing a directed recovery include being able to: 

• Obtain files from a source computer which is inoperable. 

• Perform all recoveries from a single NetWorker client in the data zone, thereby 
providing central recovery management and control. 

• Transfer files from one client to another. 
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The following access rights are required for directed recoveries: 

1. Recovery must be launched by the root user (UNIX) or Windows Administrator on the host 
performing the recovery. This host must be a NetWorker client of the NetWorker server. The 
user must have the Remote Access All Clients privilege on the NetWorker server. Note that 
users in the Administrators group on the NetWorker server are automatically granted the 
necessary privileges. 

2. The Remote access attribute in the source client’s client resource must contain the 
destination client if the user@destination client does not have the Remote Access All 
Clients privilege. 

3. The destination client must allow remote execution requests from the administering client. 
Remote execution is performed by nsrexecd. Remote execution privileges are controlled 
by the following methods: 

 The /nsr/res/servers file on the destination client lists the hosts authorized to 
make remote execution requests. 

 nsrexecd on the destination client can use the –s option to specify a host 
authorized to make remote execution requests. If this option is used, the 
/nsr/res/servers file is ignored.  

 Optionally, the Disable directed recover attribute can be set to yes in a NetWorker 
client’s resource database, /nsr/res/nsrladb. This disallows directed recoveries 
from any remote host.  (nsradmin –d /nsr/res/nsrladb) 
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The source and destination clients must be of the same platform type. You can perform 
directed recoveries between UNIX NetWorker clients and between Windows NetWorker 
clients. You cannot recover data backed up from UNIX clients to non-UNIX clients, and vice 
versa. The administering host may be a different platform type from the other clients.  

Additionally, you may not be able to recover files between dissimilar file system formats. For 
example, you cannot recover data from an NTFS file system on a Windows client to a FAT file 
system because of the way file permissions are handled. However, files from a FAT file system 
can be recovered to an NTFS file system because there are no permissions in a FAT file 
system; NTFS gives recovered files the permissions of the directory they are recovered to.  

Note: SYSTEM and VSS SYSTEM save sets cannot be recovered using a directed recovery. 
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From the NetWorker User application select the operation menu and select 
Recover/Directed Recover 
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To perform a directed recovery using NetWorker User, perform a browsable recovery. First 
select the source and destination clients. In the slide, nwwindows.emc.edu is the 
administering client, nwwindows.emc.edu is the source client and nwwindows.emc.edu is 
selected as the destination client.  

Only clients for which nwwindows.emc.edu has remote access privileges are displayed in the 
client selection windows. 

After you have selected the source and destination clients, the contents of the source client’s 
CFI is displayed, allowing you to browse and mark files for recovery in the exact same 
manner as in a normal browsable recovery. 

Upon initiating the actual recovery, the administering client contacts nsrexecd on the 
destination client and requests that it execute recover with the list of files provided. 
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Directed recoveries can also be performed using the recover command. 

The -c client option specifies the source client and the -R client option specifies 
the destination client. The required -i [YNR] option specifies what the destination client 
should do in response to file naming conflicts. 

As an example of a directed, browsable recovery, the following command is executed from 
leg1-win10 and recovers files backed up from leg1-sun9 to the client leg1-sun10, overwriting 
existing files: 

       recover -c leg1-sun9 -R leg1-sun10 –iY 

To perform a directed save set recovery using recover, use this command format: 

recover –s nw_server –R destination_client –i{NYR} –S ssid 

 

Argument Description 

Y Overwrite the existing file. 

N Do not restore (discard) the recovered file. 

R Rename the recovered file. 

Table 3-2: Arguments for –i option 
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This lesson covered directed recoveries including privileges and platform requirements and 
using the features of the NetWorker interfaces to perform directed recoveries. 
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This lesson covers snapshot recoveries including privileges and platform requirements and 
using the features of the NetWorker interfaces to perform directed recoveries. 
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There are three recovery types available from a snapshot backup. They are snapshot , 
rollover and rollback recoveries. Fast and easy recovery is another benefit for NSM. The 
NetWorker Recovery User interface steps the NetWorker through the recovery from a 
snapshot backup, as well as other backup types. The recovery from snapshot management 
includes the ability to perform a rollback which will overwrite the original data , as well as 
mount the save set from browse and recovery.  

You can perform a rollback, which reverts the entire disk to state to the time of the snapshot.  
This is done at the array-level. For example file systems E:\, F:\, and G:\ live on LUN 02E.  
Rolling back G will restore everything on LUN 02E including E:\ and F:\. 

You can also recover from the snapshot, either full or partial. If the data was rolled over to 
backup media… In short ““Whatever you can do with a NetWorker created backup to media, 
you can do with an NSM generated backup to media. “ 

Note: NSM does not support Checkpoint Restart or Synthetic Full backups. 
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Prior to NetWorker 8.1, all PowerSnap restores handled via the nsrsnap_recover CLI. 
NetWorker 8.1 introduces a Recover Wizard to provide a GUI-based recovery workflow.  
When a client is selected, if NSM is detected, the recover UI will detect all available 
Snapshots and save sets, and choices and visibilities related to recovering the data.  When 
the actual recover takes place, nsrsnap_recover is invoked, using the values collected by the 
wizard. 

The Wizard supports snapshot recovers, rollover, standard media recoveries.  The progress is 
visible in both the Wizard and the NMC Monitoring interface.  Operations are also logged to 
the standard recovery logs. 
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You can use the NMC recovery wizard GUI to restore file system data from a snapshot stored 
on a supported array. Run NMC in the enterprise view to launch application. Complete the 
select client to recover page, specify the application host whose production data is the 
source for the snapshot. Specify the application host an alternative client on which you want 
to restore the snapshot data. Available recovery types table list the different types of 
recoveries that are available for recover. Supported recovery types are Blocked based 
backup(BBB) , BBB( clone to tape) , Filesystem and Snapshot Management. 
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The window provides you with the ability to browse the snapshots to recover. Mount the 
save set for recovery and select the storage node. Then choose the destination for the 
recovery. 
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Snapshot Rollback 

1. Choose from available snapshots 

2. Choose rollback 

3. Warned about data outside of the saveset that will be affected by the snapshot 

4. Must confirm before rolling back 
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In this lab, you will perform:  

• A browsable recovery using NetWorker Recovery Wizard 

• A save set recovery using the NetWorker Recovery Wizard 

• A scheduled recovery using the NetWorker Recovery Wizard 
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This lesson covered directed recoveries including privileges and platform requirements and 
using the features of the NetWorker interfaces to perform directed recoveries. 
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This module covered how to perform recoveries of client data in NetWorker using the 
NetWorker User and recover interfaces. We looked at the three types of client recoveries 
that are supported by NetWorker: browsable, save set ,directed and snapshot. 
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